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CHAPTER 1

                                 Introduction to 3D Data: 
Modeling with ArcGIS 

3D Analyst and 
Google Earth

    Introduction to 3D Data  is a self - study tutorial workbook that teaches you how to create data and maps 
with ESRI ’ s 3D Analyst software, and to integrate them with Google Earth. 

 The datasets for all of the exercises in the book are provided online at www.wiley.com/college/kennedy. 
 You must already have ArcGIS 3D Analyst installed to use this tutorial, as the book does not come with 
any trial software.  Most of the 3D Analyst exercises can be done with versions 9.1 or 9.2 of ArcView, 
ArcEditor, or ArcInfo; some exercises require 9.3. Google Earth is free. 

 This book is designed for people who are already familiar with ESRI products, particularly ArcMap 
and ArcCatalog, but who would like to understand the ins and outs of the three - dimensional modeling 
environment. While you can do the exercises in any order, you should work through early chapters first, 
since instructions in later chapters are somewhat abbreviated. 

 3D Analyst is designed primarily to create surface elevation data and display it in three dimensions. 
It provides additional analysis functions such as viewshed, surface area, and volume calculation. Its 
original interface, ArcScene, presents data in three - dimensional space.    
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    In version 9.0 ESRI added ArcGlobe to the package, which allows you to view large datasets in a global 
format.    

ArcScene models data in three-dimensional space

 ArcGlobe models data on the earth 
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    Increasingly, however, GIS users and the general public expect to be able to view maps interactively, on 
the web, for free. This is thanks largely to Google Earth, which has revolutionized the way we view spatial 
information. ArcGIS 3D Analyst has the power to create and analyze geographic data, but Google Earth has 
the speed and intuitive interface that makes it a staple for displaying maps and sharing spatial information. 

 With 3D Analyst, you can create TIN (Triangulated Irregular Network) and raster surface models from 
any vector elevation data such as contour lines, GPS points, or survey points. In ArcScene and ArcGlobe, 
you can drape images and vector features over surfaces, fly through your GIS data in 3D perspective, 
and make movies of your flights. You can extrude 2D points, lines, and polygons into lines, walls, and 
solids, and you can create multipatch  “ true 3D ”  features. You can calculate slope, aspect, hillshade, 
volume, and surface area; create contour lines, and determine visibility from any point on a surface. You 
can also determine lines of sight, create profile graphs of a surface, and digitize 3D features and graphics.    

 An elevation raster in ArcMap 

    The same elevation raster in ArcScene    
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Parcels colored and extruded by land value

A TIN created from contour lines with faces symbolized by slope
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      3D Data Overview 
  X, Y, and Z Values 

 All geographical data contains horizontal x,y coordinate values. To work in three dimensions, you 
need data that contains z values as well. For each x,y location stored in a 3D dataset, a z value is stored 
that represents an attribute other than that location ’ s horizontal position. In a terrain model, the z value 
represents elevation, or height about sea level.         

A line of sight drawn in ArcMap

Three locations on the surface of a TIN, each 
labeled with their elevation (z) values in feet
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 3D Analyst works primarily with raster, TIN, and 3D vector feature data. Rasters and TINs are used to 
model surfaces, not just of terrain but of any phenomenon that varies continuously across an area, such 
as precipitation, chemical concentration, pollution dispersion, noise levels, population distribution, or 
soil pH.  

  Rasters 
 A raster represents a surface as a rectangular grid of evenly spaced square cells. Each cell is the same size 
and has a unique row and column address. A cell can represent a square kilometer, a square meter, or a 
square centimeter. The smaller the cells, the more detailed the raster, and the larger the file space taken 
up by the grid. 

 Since the grid is uniform, its horizontal (x,y) coordinates don ’ t need to be stored in each cell. Instead they 
are calculated from the x,y location of the lower - left cell in the grid. Each cell does, however, hold its own z 
value that represents a quantity or a category of phenomena such as elevation, crop yield, or reflected light.    

Cells in a landuse grid. All cells with the same 
value are symbolized by the same color

    While landuse could also be represented by discrete vector polygons, vector data cannot represent values 
that change gradually, or continuously, over an area.    

Cell in a continuous grid, symbolized by value 
range
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    Raster data is often divided into two categories: image and thematic. In an image, the surface 
phenomenon is the reflection or emission of light, or some other band in the electromagnetic spectrum, 
and can be measured by camera or satellite.    

An aerial photograph. Cells in this raster represent light reflected from 
the earth’s surface

    When a phenomenon such as light is measured by a camera or a satellite, each cell ’ s value represents the 
light and color at that point on the surface. A thematic raster, however, represents a category or quantity 
of a phenomenon such as elevation, pollution, population, rainfall, or noise. Since readings cannot be 
taken at every location, samples are taken instead, and a surface model is made. The model approximates 
the surface by interpolating the values between the sample points.    

A thematic raster of elevation values. A 
few of the cells represent samples actually 
taken, but most of the values have been 
interpolated

    3D Analyst uses the z value stored in each cell to display the raster in 3D. Elevation values are commonly 
shown, but any numeric cell value can be illustrated in three dimensions. Even though images and many 
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thematic rasters don ’ t contain elevation values, you can still display them in 3D by draping them over a 
3D surface model with the same geographic extent.  

   TIN s 
 A Triangulated Irregular Network (TIN) represents a surface as a set of irregularly located points, joined 
by lines to form a network of contiguous, non - overlapping triangles that vary in size and proportion. 
Each triangle node stores an x, y, and z value.        

The structure of a TIN. Top: only 
the TIN edges and nodes are 
shown. Bottom: the TIN’s triangles 
(faces) are colored to represent 
elevation

    Like rasters, the values in a TIN are interpolated from sample points. The sample points form the triangle 
nodes, and the interpolation (or triangulation, as it ’ s generally called) consists of connecting the nodes 
by lines. Once the TIN is built, the elevation of any location on a TIN surface can be estimated using the 
x, y, and z values of the bounding triangle ’ s vertices. The slope and aspect for each triangle face is also 
calculated.    
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    Because the nodes can be placed irregularly over the surface, TINs can show greater detail where a 
surface is highly varied or where you want more accuracy. A TIN is only as good as the initial sample 
points taken; mountainous areas need many more samples per square unit than flat areas do in order to 
create an accurate terrain model. 

 TIN models are less widely available than raster surface models; they take longer to build and require 
much more disk space. They are typically used for precise modeling of small areas.  

  Terrain Datasets 
 A terrain dataset represents a surface in the same way that a TIN does, but uses a different storage 
system. Elevation measurements collected by LiDAR or SONAR are typically used to create a terrain 
because they can result in millions of mass points. This enables the creation of a very accurate surface, 
but also makes for a large file size. Terrain datasets get around this by separating the TIN representations 
into multiple levels of resolution, called pyramids, for faster drawing of large datasets. At smaller scales, 
a coarser TIN representation is drawn; at larger scales, more detailed features are shown.    

When you identify any point on the face of a TIN, 
the node x, y, z values are used to interpolate the 
elevation at that point. The node values are also 
used to calculate the slope and aspect of each 
triangle face

In a lower-resolution pyramid of a terrain dataset, 
fewer triangles are calculated during display. 
This pyramid level would normally be drawn at a 
smaller scale in ArcMap
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      3D Features 
 3D vector features, like their 2D counterparts, represent objects or clearly bordered areas such as 
buildings, land parcels, roads, power poles, and wells. Often, the z values in 3D features are used to 
represent an attribute other than height. For example, you might create a scene that shows city points 
extruded into 3D columns based on their population. 

 Like TINs, 3D features store z values along with x, y coordinates as part of their geometry. A point has 
one z value; lines and polygons have one z value for each vertex in the shape. You can identify 3D feature 
classes by looking at the Shape field in their attribute tables.    

In the finest resolution pyramid, all triangulations 
are represented in the terrain dataset. This 
pyramid level would normally be drawn at a large 
scale in ArcMap

A 3D feature class shows a Z 
value in its Shape field

      2.5 - Dimensional and 3 - Dimensional Data 
 Generally, when we talk about 3D data, we mean 2.5 D data. Rasters, TINs, and terrains are surfaces that 
store exactly one z value for each x, y value pair. Also, when we turn points, lines, or polygons into 
solids, we ’ re really just extruding 2D coordinates by a set of specified values. 
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 True 3D geometric structures are represented in 3D Analyst by multipatch features. Multipatches are 
made of planar 3D rings and triangles stitched together to model objects like spheres, trees, rooftops, or 
buildings with overhanging features. 

 Software programs like Sketchup (Google ’ s free 3D modeling software), 3ds Max, OpenFlight, and VRML 
2.0 can create models that 3D Analyst can import into a geodatabase and use as symbols. They can also be 
used as graphics in ArcScene or ArcGlobe, without committing them into a geodatabase.    

3D features extruded from 2D 
polygons. Each x,y vertex has one 
companion z value

Multipatch (true 3D) features can handle multiple z values per x,y vertex, 
permitting realistic representations of features that include overhangs or 
textures
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       KML  
 KML is Google Earth ’ s file format for displaying 3D data. You may be used to seeing the most common 
form of KML document in Google Earth and Google Maps: the Placemark. This is similar to a point 
feature class in ArcGIS in that it represents a geographically referenced point on the earth. It differs 
completely, of course, in the file structure and instructions used for rendering. KML is a tag - based 
structure similar to HTML and XML that can be created or altered in any text editor. Generally, though, 
you will create 3D features directly in Google Earth, or import files created in Sketchup into Google Earth. 

 Besides Placemarks, KML allows you to create or place polygons, lines, and raster image overlays in 
Google Earth.    

A Placemark and a Polygon created in Google Earth. The KML code for the Placemark object is 
shown below:
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    Now that you ’ ve had an introduction to 3D data structures, you ’ re ready to learn how to use 3D Analyst.    

  Load the Tutorial Data 
 The next two exercises will teach you how to work with 3D data in ArcCatalog. Before you can do any 
exercises, however, you need to load the 3D Analyst tutorial data and add the ArcScene, ArcGlobe, 
ArcCatalog, and ArcMap program icons to your desktop. 

 Visit the support website for the book to download the tutorial data at www.wiley.com/college/kennedy. 
Click on the cover for Introduction to 3D Data: Modeling with ArcGIS 3D Analyst and Google Earth. On the 
next page click the link for the Student Companion Site on the right side of the page and follow the links 
for the 3DDATA.zip archive. Download the zip file to your desktop and extract the archive to the drive of 
your choice using a program such as WinZip or 7-Zip (freely available at www.7-zip.org). If you have the 
disk space, I recommend that you copy it directly under your C: drive, so that the full pathname reads 
 “ C:\3DDATA. ”  

Once the contents of the 3DDATA.zip archive are copied to your hard drive, you can delete the zip file as 
you won’t need it again.
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  Add the Program Icons to Your Desktop 
 Note: ArcGIS 3D Analyst must be installed before you can create shortcuts to it on your desktop. If you 
have not installed the software, please see the ArcGIS 3D Analyst installation guide.   

   1.   On the taskbar of your desktop, click the Start menu. Move your cursor to Programs, then ArcGIS, 
and right - click on ArcScene.  

   2.   Choose Send to  . . .  , and then click Desktop (Create Shortcut). A shortcut to ArcScene is added to 
your desktop. (This procedure is for Windows XP; if you ’ re running Windows 2000, NT, or Vista, it 
may be a little different.)  

   3.   Use the same procedure to add the ArcGlobe icon to your desktop. If you don ’ t already have desktop 
icons for ArcCatalog and ArcMap, you should add them as well.      
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  Exercise 1 - 1 

Preview Data in ArcCatalog 
 With 3D Analyst loaded in ArcCatalog, you can preview both 2D and 3D data in three dimensions. In this 

exercise, you ’ ll examine a TIN of Coletown, KY, and a 3D shapefile of contour lines.    

  Step 1. Start ArcCatalog 
 Double - click the ArcCatalog icon on your desktop. If you didn ’ t make an ArcCatalog desktop icon, either 
see the instructions immediately above, or click the Start menu, point to Programs, point to ArcGIS, and 
click ArcCatalog. 

 From the Tools menu, choose Options. 

 Click the General tab. At the bottom of the dialog, uncheck the box next to  “ Hide file extensions. ”  

 Click OK.  

  Step 2. Load the 3D Analyst Extension 
 From the Tools menu, choose Extensions. In the dialog, check the box next to 3D Analyst. Click Close.      

  Step 3. Load the 3D View Toolbar in ArcCatalog 
 From the View menu, click Toolbars and check the box next to 3D View Tools and Globe View Tools. 

 These tools let you view and navigate your data in 3D and in Globe view, query 3D features, and create 
perspective - view thumbnails. 

 Other than the Launch ArcScene button,       

 the Launch ArcGlobe button,       

 and the Create Thumbnail buttons,       

 these tools are also found on the Tools toolbars in ArcScene and ArcGlobe, respectively.    
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  Step 4. Look at ArcCatalog ’ s Contents 
 In the Catalog tree on the left, navigate to the 3DDATA\Chapter01\Data folder. Click the plus sign next to 
the Data folder to open it.     

 The 3DDATA\Chapter01\Data folder contains one TIN, one raster, and one shapefile feature class. Notice 
the icons that ArcCatalog uses to represent TIN and raster data types.  

  Step 5. Preview the  TIN  Dataset 
 Click cole_tin in the Catalog tree, then click the Preview tab above the display. The TIN is displayed in 
two dimensions (also called the orthographic or planimetric view). The faces of the TIN are colored by 
elevation value.     
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